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Chapter 1: 

Remote Control

Remote Control allows you to operate a remote computer as if you were sitting in front of it.

The Remote Control toolbar is located on the left side of the Remote Control window. Use the 
Remote Control toolbar to exit Remote Control, change Remote Control views, send a 
CTRL+ALT+DEL to the remote system, reboot the remote system, select synchronous display or 
asynchronous display, and display the Remote Control Options dialog box.

• To log into a Windows NT or 2000 system running Carbon copy as a service, use the Send 
CTRL+ALT+DEL to remote system button. This has the same effect as pressing the key 
combination CTRL+ALT+DEL on the remote computer itself.

• Pressing the Send CTRL+ALT+DEL to remote system button after you are connected to and logged 
into a Windows NT/2000 remote computer will launch the Windows NT/2000 security dialog 
box from which you may select a number of options including the Windows NT task manager.

• Pressing the Send CTRL+ALT+DEL to remote system button after you are logged into a Windows 
9x remote computer will launch a task manager from which you can view and manage running 
applications on the remote computer.

Starting Remote Control
To start Remote Control
1 Connect to a computer that is running Carbon Copy and has already been set to Wait for Calls.
2 From the Altiris Console, in the Remotely Control with Carbon Copy window, click on the Remote 

Control icon.
Notes

• The computer running the Carbon Copy Agent cannot start a Remote Control session. 
• During Remote Control the other Carbon Copy utilities are available. 
• The remote computer’s keyboard and mouse can be active, sharing control of the remote 

computer, or they can be disabled. This option is in the Input Options tab of the Remote Control 
Options dialog box.

Remotely Controlling DOS Applications
You can remotely control DOS applications in Windows. Both text and graphics mode applications 
are supported.

To run DOS applications in a Window or full-screen display
1 In the Remote Control window, open a DOS window. For example in Windows 2000, click Start 

menu > Programs > Accessories > Command Prompt.
2 Enter the DOS command at the command line.

Note: You may press ALT+ENTER to change the display of the DOS application from full 
screen to being displayed in a Window.

3 To exit the DOS windows, type EXIT and press ENTER.
Altiris Carbon Copy Solution Utilities Help 5
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Changing Remote Control Window Views

You can select how you want to view the remote computer’s screen during Remote Control. 

Full Screen - When selected, the Remote Control window completely fills the screen. If the remote 
computer’s screen display is larger than your screen display, the view of the remote computer’s 
screen will automatically scroll as you move the mouse to the edge of the screen.

When the remote computer’s screen display is larger than your screen display, you can use the 
mouse or the ALT+RIGHTSHIFT+ARROW KEYS to pan the view of the remote computer’s screen.

Windowed - Selected by default. When selected, the remote computer’s screen is displayed in a 
window on the desktop.

Stretch to Window - When selected, the remote computer’s display fills the Remote Control window 
on your desktop. Using this mode may result in a distorted view of the remote computer’s display 
and decreased performance.

To switch between Remote Control views
• Click the applicable view button on the toolbar.

Using Hot Keys to Change Remote Control Views
You can use the following hot key combinations any time during Remote Control:

• ALT+RIGHTSHIFT+ENTER is used to toggle between Full Screen and Windowed view.

• ALT+RIGHTSHIFT+F is used to switch to Full Screen view.

• ALT+RIGHTSHIFT+W is used to switch to Windowed view.

• ALT+RIGHTSHIFT+S is used to switch to Windowed Stretch view.
Notes

• You can select a different view anytime during Remote Control using the toolbar buttons or hot 
keys.

Changing Remote Control Options
To set Remote Control options on a remote computer
1 In the Remote Control window, click the Remote Control Options Property Page button on the 

Remote Control toolbar. 
2 Change the options as wanted.
3 Click OK.

Exiting the Remote Control Window
To exit the Remote Control window
Use one of the following methods to exit the Remote Control window: 

• In the Remote Control window, click the Exit button on the toolbar.
• In the Remote Control window, use the selected Hot Key combination, for example 

ALT+RIGHTSHIFT.

Note: Exiting the Remote Control window does not close the Carbon Copy connection between the 
computers. To close the Carbon Copy connection, at the Altiris Console’s Remotely Control with 
Carbon Copy window, click the Disconnect button.
Altiris Carbon Copy Solution Utilities Help 6



 

Chapter 2: 

File Transfer

File Transfer allows you to copy, synchronize and delete complete directories and individual files 
and to create or remove directories on your own computer or the connected computer.

Using the File Transfer Window
File Transfer is similar to Windows Explorer, using the same directory tree structure, and many of 
the same keyboard and mouse techniques.

The top window represents the computer that started the File Transfer utility and has My Computer 
in the window title.

The bottom window represents the remote computer and has computer’s workstation name in the 
window title.

When the File Transfer window opens, a File Transfer taskbar button appears on the remote computer.

The user at the remote computer can maximize the File Transfer window and either user can transfer 
files between computers.

If either user closes the File Transfer utility, the File Transfer utility is closed on both computers.

Selecting Directories and Files 
Selecting directories and files in File Transfer is similar to Windows Explorer.

• To select a single file, click on it.
• To select multiple adjacent files, click on the first file then hold down the SHIFT key while 

selecting the last file in the group. The files in between will be selected.
• To select multiple files not in sequence, click on the first file, press and hold down the CTRL key 

and click on the next file you want to select.

Refreshing the File Transfer Window
If other applications create, rename, or edit directory information while File Transfer is running, 
your File Transfer windows may need to be refreshed. 

To update the information in your File Transfer window
• Choose Refresh from the View menu, or press F5.

Copying and Synchronizing Directories and Folders
Synchronizing files is a fast and efficient way to update files between the connected computers. 
When you select directories to be synchronized, both directories are updated with the most recent 
files from both computers. For example, if you are synchronizing a directory on your computer at 
Altiris Carbon Copy Solution Utilities Help 7
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home with a directory on your computer at work, and the directory on your work computer contains 
files that are not currently in the directory on your home computer, the new files from your computer 
at work will be added to the directory on your home computer.

Files being synchronized are compared by date, time, and size to determine if they need to be 
synchronized. If you want to synchronize files that have the same date, time, and size, but contain 
different information, select Use Full File Comparison on the Transfer tab of the File Transfer Options 
dialog box. 

When synchronizing files, make sure the name of the files are exactly the same on both computers.

If the other computer’s File Transfer window is open while you are copying or synchronizing files, a 
dialog box appears on the remote computer stating that files are being synchronized. The other user 
cannot perform File Transfer tasks while this dialog box is displayed. This dialog box does not 
appear if the other user’s File Transfer window is minimized.

Directories and files are copied or synchronized from the computer, which has the focus, to the 
computer which does not have the focus. 

You can copy and synchronize files from only one directory at a time, and they must all be copied 
into a single directory on the other computer.

When a file in the destination path has the same name as one you are copying or synchronizing, you 
will be alerted, if File Replace is selected in the Confirmation tab of the File Transfer Options dialog 
box. When it is cleared, you are not warned, and the existing file is automatically overwritten.

If you click on the Background button in the Copy or Synchronize dialog box, you can work in another 
applications while you copy or synchronize directories and files in the background.

Only one user can copy or synchronize files at a time.

To copy from one location to another on your own computer, use Windows File Manager.

If the Include Subdirectories option in the File Transfer Options dialog box is selected, the 
subdirectories in the directory will also be copied.

To copy or synchronize directories or files using drag and drop
1 Select the source drive, directory, and files to copy or synchronize.
2 Do one of the following:

• To copy, drag the selected directory or files to the destination drive and directory.
• To synchronize, press and hold CTRL while dragging the selected directory or files to the 

destination drive and directory. 
3 When the Confirm Folder Copy/Synchronize dialog box appears, verify that the information is 

correct and click Yes or Yes To All.
4 When the Copy or Synchronize dialog box appears, do one of the following:

• To copy or synchronize the files and keep the File Transfer interface open, click Copy or 
Synchronize. 

The dialog box shows the status of the transfer. The Copy List or Synchronization List field 
shows the number of files remaining to copy or synchronize and their names. Before or 
during copying or synchronizing, you can select files from this list and choose Remove from 
Copy/Synchronization List if you decide not to copy or synchronize them. 

• To copy or synchronize the files in the background, click Background.

File transfer interface is minimized and the directories and files are copied or synchronized. 
You can continue to work in another application.
You can click the Background button anytime during a file transfer.
When the file transfer is complete, the dialog box reappears. The information in the dialog 
box indicates how much of the selected directory or file was transferred and how long the file 
transfer took to complete.

5 When done click Close.
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Creating a Folder

To create a new folder
1 Select the directory where you want to create the new folder.
2 Choose New File, located on the File menu. 
3 When the new folder icon appears in the selected directory, type a name for the folder.

Deleting Files and Directories
To delete files or directories
1 Select the drive and/or directory that contain the file(s) to delete.
2 Select the files to delete. You can select files from only one directory at a time.
3 Click File > Delete. 

If File Delete is selected in the File Transfer Options dialog box’s Confirmation tab, a dialog box 
appears and displays the directory and filename of the first several files and directories to be 
deleted. An ellipsis indicates more files.

4 Do one of the following:
• To delete the directories or files, click Yes. Each file is displayed as it is deleted.
• To delete all the files and directories without confirming each one, click Yes to All.
• To not delete the specified file or directory, click No.
• To cancel deleting files and exit the dialog box, click Cancel.

Canceling a File Transfer
To cancel a file transfer you started
1 From the Copy dialog box or from the Synchronize dialog box, when the file transfer is in process 

click Abort. 
2 When the File Transfer Error dialog box appears with the message “User aborted transfer”, click 

OK.

To cancel a file transfer the other user initiated
• When a remote computer starts a file transfer, a Copy or Synchronize dialog appears on your 

computer if your File Transfer window is not minimized. To cancel the file transfer in progress, 
click Abort.
When you abort the file transfer, the connected user will see a dialog box stating that the file 
transfer has been aborted.

Setting File Transfer Options
1 Open the File Transfer Options dialog box by clicking View > Options.
2 Set the wanted options:

• To restrict directories and files from File Transfer, click the Directory Restrictions tab, 
select the directories that you want to restrict access to, and click the Restrict/Allow Access 
button.
A symbol will appear on the selected directories, indicating that access has been restricted. 
Connected users will not be able to access these directories.
To remove access restrictions from selected directories, click the Restrict/Allow Access button 
again.
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• To set your computer to disconnect from the remote computer when a file transfer is 

completed, click View > Options, click the Transfer tab, and select Disconnect After Transfer.
• To set your computer to use file compression when transferring files, click the Transfer 

tab and select Use Compression.
Note: If you are transferring files or data that is already compressed, turn Compression off.

• To set the Enable Crash Recovery option, click the Transfer tab and select Enable Crash 
Recovery.
The Enable Crash Recovery option allows you to continue with a file transfer or 
synchronization even if you have lost the connection with the remote computer. The next 
time you start the file transfer or synchronization, simply select the same files and restart the 
transfer. Carbon Copy will automatically resume the transfer at the point where the 
connection with the remote computer was lost.
Note: If you are transferring files or data that is already compressed, turn Compression off.

3 Click OK.

File Transfer Options Dialog Box
The File Transfer Options dialog box is opened by clicking View > Options. It has a Transfer tab, an 
Include tab, a Confirmation tab, and a Directory Restrictions tab.

Transfer Tab
Compressing Options
Use Compression

When selected (which is the default), additional file reduction techniques based on the type of files 
transferred are used. These techniques will not effect data integrity, but may change the binary 
representation of the files.

Copy & Synchronize Options
Enable Crash Recovery

When selected (which is the default), you can continue with a file transfer or synchronization even 
if you have lost the connection with the remote computer. The next time you start the file transfer or 
synchronization, simply select the same files and restart the transfer. Carbon Copy will 
automatically resume the transfer at the point where the connection with the connected computer 
was lost.

Include Subdirectories

When selected (which is the default), all subdirectory in the selection are included for a copy or 
synchronization. If not selected, subdirectories will not be copied or synchronized.

Copy Existing Files Only

When selected, only the files that already exist on the connected computer are copied or 
synchronized. For example, if you choose to copy a file, but a file with that name does not already 
exist on the connected computer, the file will not be copied.

Copy Newer Files Only

When selected, only the files with a more recent date than files with the same name on the connected 
computer are copied or synchronized.

Copy Empty Directories

When selected, empty directories are copied to the connected computer. The new, empty directory 
is created on the connected computer. 

Overwrite Read Only-Files

When selected, read-only files on the destination computer will be overwritten.
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Use Full File Comparison

When selected, compares files that have the same date, time, and size. The files are checked to see 
if they contain different information, even though they have the same date, time, and size.

General Options
Allow Incoming File Transfers

When selected (which is the default), allows the computer to transfer files to connected computers. 
If you clear this option, you cannot receive files from another computer.

Allow Outgoing File Transfers

When selected, (which is the default), allows you to transfer files to connected computers. If you 
clear this option, you cannot send files to another computer.

Close Dialog After Transfer

When selected, automatically closes the dialog box when a file transfer is completed. 

Disconnect After Transfer

When selected, automatically disconnects the attached computer after the file transfer completed.

Include Tab
Use the options on this tab to select the types of files that will be displayed in the File Transfer 
window.

Name Field

Displays all files with the specified name or extension. You can use wildcard characters in this field. 
Use the ? character to represent any character. Use the * character to represent a series of characters.

File Type
Programs - When selected, displays all files that have a .exe, .com, .pif, or .bat extension.

Documents - When selected, displays all files that are associated with an application.

Other Files - When selected, displays all other files.

Show Hidden/System Files
Check box - When selected, displays hidden and system files.

Confirmation Tab
Select the actions that you want to confirmed when using File Transfer. 

Confirm On
Confirm on File Delete - When selected, a confirmation dialog box appears when you delete a file.

Confirm on Folder Delete - When selected, a confirmation dialog box appears when you delete a 
folder.

Confirm on File Replace - When selected, a confirmation dialog box appears before a file being 
replaced is allowed to overwrite an existing file with the same name.

Confirm on Folder Copy - When selected, a confirmation dialog box appears before a file being copied 
is allowed to overwrite an existing file with the same name.

Confirm on Folder Synchronize - When selected, a confirmation dialog box appears before a folder 
being synchronized is allowed to overwrite an existing folder with the same name.
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Directory Restrictions Tab
Controls access to directories and files on the computer from remote computers.

Navigation window - Select the directories that you want to control access to.

Restrict/Allow Access - Restricts or allows access to the selected directories or files in the navigation 
window. A symbol is displayed on directories and files when access is restricted.

Copy / Synchronize Dialog
Use this dialog to copy or synchronize files from the local computer to the remote computer, or vice 
versa. 

Copy or Synchronize button – Copies or synchronizes selected files or directories.

Background button –  Used to copy or synchronize files in the background. File Transfer appears as 
an icon at the bottom of the screen. You can use other applications while Carbon Copy is copy or 
synchronizing files.

From Local Folder field – Contains the full path name of the directory from which files are being 
copied or synchronized.

To Remote Folder field  – Contains the directory to which the files are being copied or synchronized.

Current File field  – Displays the name of the file currently being copied or synchronized.

File Size field  – Shows the size in bytes of the file being copied or synchronized.

Bytes Sent field – Shows the total number of bytes sent.

Copy / Synchronize List – Shows the name of each file to be copied or synchronized. If you have 
selected to copy or synchronize subdirectories, files in the subdirectories will also be listed.

Remove from Copy List – Click to remove the currently selected file from the Copy List. When you 
remove a file from the Copy List, it will not be copied. You may select multiple files.

Files Remaining field  – Shows the number of files remaining to be copied or synchronized.

Files Complete field  – Shows the number of files already copied or synchronized.

Transfer Time field  – Shows how much time has elapsed since file copy or synchronization began.

Throughput (CPS) field  – Shows the current effective throughput in characters per second.

Percent of Current File Complete field  – Shows what percentage of the file currently being copied or 
synchronized has been sent.

Percent of All Files Complete field  – Shows what percentage of all the files to be copied or 
synchronized has been sent.
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Chapter 3: 

Remote Printing

Computers running the Altiris Console, the Carbon Copy Console, or the Carbon Copy Agent can 
be set up to use Remote Printing. The remote printing feature allows users at connected computers 
to print documents on the remote computer. 

For remote printing to work, Remote Printing must be running and the source computer (where the 
file is that you want to print) must have a printer defined with properties that use the 
Carbon_Copy_Printer port and the same printer driver as the destination computer’s default printer.

For example, if the destination printer is an HP LaserJet 4, then the source computer should have a 
printer definition configured to use the Carbon_Copy_Printer port and the HP LaserJet 4 printer 
driver. If the destination computer’s default printer is changed, the source computer’s printer 
definition must be reconfigured to use the same printer driver as the destination computer’s default 
printer driver.

Remote Printing works only from Windows applications. It is not possible to print remotely from a 
DOS application.

Configuring Remote Printing
Before you can use Remote Printing, you need to configure the source computer (where the file is 
that you want to print) to print to a local printer that uses the Carbon_Copy_Printer Port and has the 
same drivers as the destination computer’s default printer.

To configure remote printing on the source computer
1 From the Windows start menu, click Start > Settings > Printers.
2 Double click on the Add Printer icon in the Windows Printers folder.
3 Select Local Printer or My Computer. Click Next.
4 The following steps may appear in reverse order depending on the computer’s operating system:

a Select the Carbon Copy Printer Port. Click Next.
b Select the destination computer’s printer manufacturer and model. Click Next.
c Type in a printer name. For example, HP LaserJet via Carbon Copy. Click Next.
d For Windows NT/2000, you will be prompted to share the printer. Click Not Shared and then 

click Next.
5 Follow the remaining steps to install the printer.
Notes

• The source computer’s default printer does not have to be set to remote printer definition.
• Bidirectional support must be disabled. To verify, right click on the remote printer’s icon and 

select Properties. For Windows 98/Me, select the Details tab, click on Spool Settings, and verify 
that bidirectional printing is not checked. For Windows NT/2000, select the Ports tab and verify 
that bidirectional support is not enabled.
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Printing to a Remote Printer

Remote Printing works only from Windows applications. It is not possible to print remotely from a 
DOS application. The print destination computer should be configured to print to a normal printer - 
a printer that is not configured to use the Carbon Copy Printer Port.

To print to a remote printer
1 Make sure you have a printer defined to use Remote Printing. See “Configuring Remote 

Printing” on page 13.
2 Make sure that you have a connection to the destination computer and Remote Printing is 

running.
Important: The Remote Printing utility can not be started from the Carbon Copy Agent. It must 
be started from the Altiris Console’ Remotely Control with Carbon Copy window or the Carbon 
Copy Console. 

3 Make sure that the destination computer’s default printer uses the same print driver as the source 
computer’s printer for remote printing.
If the destination computer’s default printer does not use the same print driver as the source 
computer’s printer for remote printing, the source computer’s printer definition must be 
reconfigured to use same printer driver as the destination computer’s default printer driver.

4 Print the file from the application or from Windows explorer using the printer defined for the 
destination computer.
The print job will be printed on the printer connected to the destination computer.

Remote Printing Options Dialog Box
The Remote Printing Options dialog box has a Printer Selection tab.

Remote Printing > Printer Selection Tab
Only configure these options on the destination computer (where the printer is that will be receiving 
the print job) only.

Select the printer attached to this PC - Select the printer on the destination computer you want remote 
print jobs printed to. If no printer is selected, Carbon Copy uses the Windows selected default 
printer.

Printer Setup - Opens the Printers and Faxes window.

Add New Printer - Starts the Add Printer Wizard.

Only set these options on the computer that will be receiving the print job.
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Chapter 4: 

Remote Clipboard

When computers are connected using Carbon Copy, they can share a common clipboard. The 
clipboard shared by the connected computers is referred to as the Remote Clipboard. Using the 
Remote Clipboard, you can cut or copy text and graphics from an application on the remote 
computer using the Remote Control window and paste them directly into an application on the local 
machine, or vice versa. 

Opening Remote Clipboard
To start Remote Clipboard
1 From Altiris Console’s Remote Control with Carbon Copy windows toolbar, click the Clipboard 

button. A Remote Clipboard button appears on the remote computer’s taskbar.
2 A remote user can use a Remote Control window or the local user can open an application on the 

computer and cut (CTRL-X) or copy (CTRL-C) the information to the shared Remote Clipboard.
3 Open the application on the connected computer into which you want to paste the items.
4 Select Paste from inside the application to paste the items.

Closing Remote Clipboard
To close Remote Clipboard
1 From Altiris Console’s Remote Control with Carbon Copy windows toolbar, click the Clipboard 

button.
2 When the dialog box appears asking “Are you sure you want to terminate Remote Clipboard?”, 

click Yes.



 

Chapter 5: 

Voice Chat

The Voice Chat feature allows a user of the Altiris Console’s Remotely Control with Carbon Copy 
window or the Carbon Copy Console to speak with users on computers running the Carbon Copy 
Agent even while they run Remote Control, File Transfer, or any other utility. Any number of 
Carbon Copy users, connected to a central computer, can speak with one another. While using Voice 
Chat, you can also exchange messages with the users of a connected computer by entering text in 
the fields at the bottom of the Voice Chat window. You can copy text chat messages to the Windows 
Clipboard and paste it into other applications, or copy text from an application and paste it into the 
text chat window

You must have a sound card, speakers, and a microphone on each computer for the audio component 
of Voice Chat to work. If a computer is not equipped for the audio, you can still exchange messages 
using text chat.

Starting a Voice Chat Session
To start a Voice Chat session
1 At the Altiris Console’s Remotely Control with Carbon Copy window or the Carbon Copy Console 

start the Voice Chat session by clicking the Voice Chat button. 
A dialog box requesting a voice chat will appear on the remote computer. The user at the remote 
computer must click OK to enter the session. When the remote user accepts the invitation, the 
Voice Chat window will appear on both computers. While in the session, the local computer’s 
audio data is sent to the remote computer’s speakers and vice versa until the session is ended.

2 While in a Voice Chat session, 
• To adjust the speaker volume and microphone volume, move the sliders in the Speaker 

Volume or Microphone Volume box.
• To mute the speakers or microphone, select the Mute check box in the Speaker Volume or 

Microphone Volume box.
• You can type text messages to all connected users. Select the box at the bottom dialog box, 

type your message, and press ENTER to send your text message. 
You can type any printable ASCII character, plus CTRL+G (beep) and BACKSPACE.
The message automatically appears on the other computer and the other computer’s message 
will automatically appear in the other section of the window.
You can scroll to view older text that scrolls out of view.
To decrease the size of the Voice Chat window, click on View and select Hide Audio Controls.
If the other user’s Chat window is not active, any text you send is ignored. You will hear a 
beep when you type, but the other user will not know you are sending text.

• To end the session, click the Close button in the upper right corner of the Voice Chat window.
Notes

• Input, output, and background noise suppression levels may require adjustment for highest sound 
quality.

• During a voice chat session, the quality of the audio heard by either user may decrease as more 
Carbon Copy tools are used, or while the applications are performing data-intensive tasks.
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• If your sound card does not support full-duplex operation, red and green status lights will appear 

in the upper right corner of the Voice Chat dialog box. When the green status light is on, your 
voice is transmitted to the other user. When the red light is on, the other user is speaking to you, 
and your voice is not transmitted.

Starting a Voice Chat Conference Session
You can use Voice Chat to set up a multiple user Voice Chat conference. In a Voice Chat conference, 
the first computer that is connected to becomes the conference server. Other Carbon Copy users can 
then connect to the conference server computer and launch Voice Chat.

For example, if User 1, User 2, and User 3 want to establish a Voice Chat conference, User 1 
connects to User 3, and launches Voice Chat. User 3 automatically becomes the conference server. 
User 2 can now connect to User 3 and launch Voice Chat. Voice can be sent and heard by all three 
users.

Both the conference server computer and the guest computers should have Voice Chat set to full 
duplex. This allows multiple users to speak at the same time. If one computer in a conference session 
is configured for half duplex, then all conference members’ computers will be forced to use half 
duplex. You may want to use half duplex Voice Chat to limit the amount of data being transferred. 
This may increase the performance of your session.

To Start a Voice Chat Conference session
1 User 1 sets Carbon Copy to Wait for Call.
2 Others users connect to User 1.

Important: Users may establish connections with the Voice Chat conference server using any 
connection method including modems, IPX, TCP/IP, direct connection, and dial-up networking.

Copying and Pasting Chat Text
You can copy chat text into the Windows Clipboard, and later paste it into other applications. Also, 
you can copy text from an application into the Windows Clipboard, and paste it into the chat entry 
field.

To copy the Chat text to the Windows Clipboard
1 Make the Voice Chat window active.
2 Select the text in the chat window and press CTRL-C.

To paste text from the Windows Clipboard into chat field
1 Make the Voice Chat window active.
2 Click inside the chat entry field, press CTRL-V, press ENTER.

Setting Input Options 
To set Input options
1 Select the input device that Carbon Copy will use when running Voice Chat.
2 You can adjust the output level automatically or manually:

• If you select Use Automatic Setting, click the Configure button to set the input level for your 
microphone/sound card.

• If you select Use Manual Setting, move the slider to the desired level.
3 You can adjust the background noise level automatically or manually:

• If you select Use Automatic Setting, click the Configure button to set the background noise 
level for your microphone/sound card.
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• If you select Use Manual Setting, move the slider to the desired level.

4 Click OK.

Setting Output Options 
To set Output options
1 Select the output device that Carbon Copy will use when running Voice Chat.
2 You can adjust the output volume level manually pressing the Play Sample button and moving 

the slider to the wanted volume level.
3 Click OK.

Voice Chat Options Dialog Box
The Voice Chat Options dialog box has a General tab, Output tab, and Input tab.

Voice Chat > General Tab
Select audio (.wav) file you would like played when someone wishes to chat with you - The list contains 
audio files that can be played when a remote user requests a chat. Voice Chat alerts you of incoming 
calls with an audio announcement. 

Test - When clicked, plays the selected audio file.

User Name. Used to display conference participants - Enter the name you want displayed to conference 
participants. - The computer name will be used by default.

Disable Audio - When selected, disables the use of all incoming and outgoing audio during a Voice 
Chat session.

Force half-duplex - When selected, forces half-duplex for all computers participating in a voice chat 
conference. Voice Chat is a full duplex application, which can record and play audio simultaneously. 
However, not all audio cards support this feature. To use Voice Chat on audio cards that do not 
support full duplex, select Force half-duplex.

Voice Chat > Output Tab
The Output tab sets the device and volume level used when speaking through a Voice Chat 
connection. You can adjust the output wave device and the output volume.

Voice Chat > Input Tab
The Input tab sets the device, volume, and noise suppression levels used when someone is speaking 
to you through a Voice Chat connection. You can adjust the input wave device, the input level, and 
the background noise suppression level.
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